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• Exercise 1: Building a catalog of

geographic data

• Exercise 2: Exploring data and
adding it to a map

• Exercise 3: Managing shapefiles

ArcCatalog lets you explore and manage your data. After connecting to
your data, use the Catalog to explore its contents. When you find the data
you want to use, you can add it to a map. Often, when you get data for a
project, you can’t use it right away; you may need to change its projection
or format, modify its attributes, or link geographic features to attributes
stored in another table. When the data is finally ready, you should document
its contents and the changes you have made. These data management
tasks can all be accomplished using tools that are available in the Catalog.

The easiest way to find out what you can do with ArcCatalog is to com-
plete the exercises in this tutorial.

• Exercise 1 shows you how to build your own catalog of geographic data
by adding data to and removing data from the Catalog.

• Exercise 2 illustrates how to explore and search for data and how to add
it to a map.

• Exercise 3 shows you how to define a data source’s coordinate system,
modify its contents, join attributes in another table to the data, and
symbolize features based on the joined attributes.

This tutorial is designed to let you work at your own pace. You’ll need
between two and four hours of focused time to complete the tutorial.
However, you can also perform the exercises one at a time if you wish.

Quick-start tutorial
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8 USING ARCCATALOG

What’s in the Catalog?

On the left of the ArcCatalog window, you see the Catalog
tree; it gives you a bird’s-eye view of how your data is
organized. On the right are tabs that let you explore the
contents of the selected item in the Catalog tree.

The first time you start ArcCatalog, it contains folder
connections that let you access your computer’s hard
disks. The Catalog also contains folders that let you create
and store connections to databases and GIS servers as well
as manage search results.

Exercise 1: Building a catalog of geographic data

When you build a catalog, you’re choosing the data you
want to work with. You might use several folders of data to
complete your project, while someone else might use data
stored in a geodatabase. For this tutorial, you’ll be working
with data from Yellowstone National Park, which is located
in the northwestern part of the United States.

In this exercise, you’ll add the folder containing the tutorial
data to the Catalog. Because you modify this data in later
exercises, you’ll create a working copy of the folder, then
remove items that you don’t need from the Catalog.

Start ArcCatalog

Before you can complete the tasks in this tutorial, you must
start ArcCatalog.

1. Click the Start button on the Windows taskbar.

2. Point to Programs.

3. Point to ArcGIS.

4. Click ArcCatalog. The ArcCatalog window appears.
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QUICK-START TUTORIAL 9

When you select a connection, you can access the data to
which it’s linked. Folder connections let you access folders,
or directories, on local disks or shared folders on the
network. Database connections let you access the contents
of a database. When you remove folder or database
connections from the Catalog, you are only removing the
connection, not deleting the data.

Together, your connections create a catalog of geographic
data sources. Individual folders and data sources are items
in that catalog. If you use ArcInfo Workstation, you’re
accustomed to using the term “item” when referring to a
coverage’s attributes; in this book, “item” refers only to an
element in the Catalog tree.

Look in a folder connection

When you select a folder connection in the Catalog tree, the
Contents tab lists the items it contains. Unlike Windows
Explorer, the Catalog doesn’t list all files stored on disk; a
folder might appear empty even though it contains several
files. Folders containing geographic data sources have a
different icon to make your data easier to find.

Look in a folder connection in your catalog.

1. Click a folder connection in the Catalog tree. The items
it contains appear in the Contents tab.

2. Double-click a folder in the Contents list. That folder is
selected in the Catalog tree, and the Contents tab lists
the folders and geographic data it contains.

Using this method, you can browse through the contents of
disks looking for geographic data.

Locate the tutorial folder

Before you can start exploring the data for this tutorial, you
must select the folder where the tutorial data is located. In
the Catalog, you can quickly select any folder on your
computer or on the network as long as you know its path.

1. Click in the Location text box.

2. Type the path to the ArcGIS\ArcTutor folder on the
local drive where you installed the tutorial data; for
example, type “C:\ArcGIS\ArcTutor”.

If the data was installed by your system administrator in
a shared folder on the network, the path to the tutorial
folder includes the names of the computer and the
shared folder through which the folder is accessed; for
example, “\\dataserver\public\ArcGIS\ArcTutor”.

3. Press Enter. The folder is selected in the Catalog tree.
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10 USING ARCCATALOG

When the Catalog already contains a folder connection that
can access the ArcGIS\ArcTutor folder, that connection
expands, and the tutorial folder is selected in the Catalog
tree. Otherwise, a new folder connection is added to the
Catalog that directly accesses the ArcGIS\ArcTutor folder.

The path you typed above is added to the Location list after
you press the Enter key. To access the ArcGIS\ArcTutor
folder again in the future, you can choose its path from the
list by clicking the Location dropdown arrow.

Create a working copy of the tutorial data

In Exercises 2, 3, and 4, you will create new items and
modify the data provided for this tutorial. When processing
data, it is best to work on a copy so that your original data
will remain unmodified. To prepare for those exercises, use
ArcCatalog to copy the ArcTutor\Catalog folder to a
location where you have write access. You will need
15 MB of free disk space to store the tutorial data.

1. If the Catalog doesn’t have a connection to the place
where you want to store the tutorial data, type its name
into the Location combo box and press Enter; for
example, type “C:\”. A new folder connection will be
added to the Catalog. Substitute the name of your folder
connection for “C:\” in the following steps.

2. Click the ArcGIS\ArcTutor folder or folder connection
in the Catalog tree.

3. Click the Catalog folder in the Contents tab.

4. Click the Copy button.

5. Click the C:\ folder connection in the Catalog tree.

6. Click the Paste button. A new folder called Catalog will
appear in the Contents list for the C:\ folder connection.

7. Click the new Catalog folder in the Contents tab.

8. Click the File menu and click Rename.

9. Type “Cat_Tutorial” and press Enter.

If you type another name for the folder, that name must
have 13 characters or less and cannot use spaces.
Because the tutorial data includes coverages, the
folder’s name must satisfy these requirements for
ArcInfo workspaces. For the rest of the tutorial, substi-
tute the name of your folder for “C:\Cat_Tutorial”.

Now that you have a working copy of the tutorial data, you
can connect directly to it in the Catalog.

Connect directly to your copy of the tutorial data

Folder connections in the Catalog can access specific
folders on disk. You might establish several connections to
different folders on the same disk. You don’t have to see all
the data on your C:\ drive, for example, just because you
want to use data in two of the folders it contains.

To create a connection that directly accesses a folder, you
can use a shortcut provided by the Catalog.

1. Click the Cat_Tutorial folder in the Contents list.Copy Paste
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QUICK-START TUTORIAL 11

2. Scroll to the top of the Catalog tree.

3. Drag the Cat_Tutorial folder from the Contents tab and
drop it on the Catalog at the top of the Catalog tree.

A new folder connection is added to the Catalog.

Creating folder connections using this shortcut is handy
when you’re browsing through local disks that contain many
folders, some of which contain geographic data.

Remove folders that you don’t need

For the remaining tasks in this tutorial, you only need to use
the folder connection that accesses your working copy of
the tutorial data. You can remove all other folder connec-
tions from the Catalog. To hide folders such as Database
Connections, you must change the settings in the Catalog’s
Options dialog box.

1. Click the C:\ folder connection.

2. Click the Disconnect From Folder button. The connec-
tion is removed from the Catalog.

3. Repeat steps 1 and 2, removing each folder connection
in turn, except for the C:\Cat_Tutorial folder connection.

4. Click the Tools menu and click Options.

5. Click the General tab.

6. In the top level entries list, uncheck Address Locators,
Database Connections, and GIS Servers. Toolboxes and
Coordinate Systems and are unchecked by default.

7. Click OK.

Only the C:\Cat_Tutorial folder connection and the Search
Results folder remain in the Catalog. Now you can explore
the tutorial data without seeing unnecessary folders and
data.

You can continue on to Exercise 2 or stop and complete the
tutorial at a later time. If you do not move on to Exercise 2
now, do not delete your working copy of the tutorial data
and do not remove the folder connection that accesses the
working copy of the tutorial data from the Catalog.

Disconnect From Folder
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12 USING ARCCATALOG

Each of the Catalog’s three tabs provides a different way to
explore the contents of the selected item in the Catalog
tree. Within each tab there are different views that let you
change the appearance of the selected item’s contents.

The Contents tab lists the items contained by the selected
item in the Catalog tree, for example, the items in a folder.
When a data source such as a shapefile is selected, the
Preview tab lets you see the geographic or attribute data it
contains. The Metadata tab lets you see documentation
describing the item’s contents.

ArcCatalog and ArcMap work together to make it easy to
build maps. For your project you are mapping the forest
resources in the southeastern corner of Yellowstone Na-
tional Park. In the Yellowstone folder is a map of the study
area; it is incomplete. In this exercise, after exploring the
data in the folder, you’ll add more data to the map.

The Contents tab

When you select items, such as folders or geodatabases in
the Catalog tree, the Contents tab lists the items they
contain. To change the appearance of the Contents list, use
the appropriate buttons on the Standard toolbar.

The Large Icons view represents each item in the list with
a large icon. List view uses small icons. Details view shows

properties of each item in columns; you can sort the list by
the property values. Thumbnails view displays a snapshot
for each item in the list, providing a quick illustration of the
item’s geographic data.

Items such as maps, shapefiles, and tables don’t contain
other items. When you select them in the tree, the Contents
tab lists the item’s properties and its thumbnail.

Explore the contents of the Yellowstone folder

Each type of geographic data has its own set of icons in the
Catalog. The Yellowstone folder contains a personal
geodatabase, coverages, shapefiles, raster datasets, a TIN
dataset, a dBASE® table, and an ArcMap map document.
Geodatabases let you store spatial data inside a relational
database; personal geodatabases can be accessed by only
one person at a time. For more information, see Chapter 3,
‘Catalog basics’.

The Yellowstone folder also contains two layers. A layer
includes a shortcut to geographic data and information, such
as the symbology used to draw geographic data on a map,
the query used to select which features the layer repre-
sents, and properties defining how those features are
labeled.

Use the Contents tab to find out about the data in the
Yellowstone folder.

1. Double-click the C:\Cat_Tutorial folder connection in
the Catalog tree.

2. Click the Yellowstone folder in the Catalog tree.

3. Click the Large Icons button.

Exercise 2: Exploring data and adding it to a map

Large Icons Thumbnails

DetailsList
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QUICK-START TUTORIAL 13

4. Click the List button.

5. Click the Details button. The Type column in Details
view will help you learn which icon represents which
type of data. You can find more information about data
types and their icons in Chapter 4, ‘What’s in the
Catalog’.

6. Click the heading of the Type column to sort the items
by type.

7. Click the heading of the Name column to sort the items
by name. When sorted by name, items that contain other

items, such as geodatabases and coverages, always
appear at the top of the Contents list. They are grouped
by type.

8. Click the Thumbnails button and scroll down through the
snapshots. Items that are not geographic data sources,
such as the yellowstone geodatabase, can’t have
thumbnails; their icons appear on a gray background.

9. Click the Details button.

10. Double-click the yellowstone personal geodatabase in
the Contents tab. It contains a feature dataset called
water and a feature class called roads.

11. Double-click the water feature dataset in the Contents
tab. It contains three feature classes: lakes, rivers, and
streams.

12. Click the states coverage in the Catalog tree to list the
feature classes it contains.
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14 USING ARCCATALOG

13. Click the tin_study TIN dataset in the Catalog tree. This
surface represents the terrain of the study area. Be-
cause a TIN dataset doesn’t contain other items, the
Contents tab lists its properties and thumbnail instead.

Thumbnails give you a quick look at an item’s geographic
data; they’re useful when browsing through folders. How-
ever, you must often see the data in more detail to deter-
mine whether or not you want to use it.

The Preview tab

The Preview tab lets you explore the selected item’s data in
either Geography or Table view. For items containing both
geographic data and tabular attributes, you can toggle
between the Geography and Table views using the
dropdown list at the bottom of the Preview tab.

Geography view draws each feature in a vector dataset,
each cell in a raster dataset, and each triangle in a TIN
dataset. When drawing geographic data, the Catalog uses a
default set of symbology. When drawing a layer’s contents,
the Catalog uses the symbology stored in the layer. You can
explore the selected item’s geographic data using the
buttons on the Geography toolbar.

Table view draws all rows and columns and the value for
each cell in the selected item’s table. You can explore the
values in the table using the scroll bars, the buttons at the
bottom of the table, and the context menus that are avail-
able from the column headings.

Look at the Yellowstone data in Geography view

Use Geography view to look at the data contained by the
items in the Yellowstone folder. When using Geography
view, the Geography toolbar is enabled. You can use the
Zoom In, Zoom Out, Pan, Full Extent, and Identify buttons
on the toolbar to explore geographic data.

While you look at the Yellowstone data, you may wish to
see the geographic features in more detail using these tools.

Full ExtentZoom Out

Zoom In Pan Identify
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QUICK-START TUTORIAL 15

For more information about how these buttons work, see
Chapter 7, ‘Exploring an item’s geography’.

1. Click the dem30 raster dataset in the Catalog tree. This
dataset contains elevation information for the study area
within the park.

2. Click the Preview tab. The raster draws using the
default grayscale color ramp.

3. Click the elevation layer in the Catalog tree. The raster
draws using the symbology stored in the layer—a green
to red color ramp.

4. Click the study_area shapefile in the Catalog tree. It
represents the study area for this project, which lies in
the southeastern corner of the park.

5. In the Catalog tree, click the plus sign next to the
vegetation coverage. The coverage’s feature classes
are listed in the Catalog tree.

6. In the Catalog tree, click each feature class in the
vegetation coverage in turn and look at their contents in
Geography view. This polygon coverage represents the
different types of vegetation within the study area.

7. Click the Preview dropdown arrow at the bottom of the
Preview tab and click Table.

8. In the Catalog tree, click each feature class in the
vegetation coverage in turn and look at their contents in
Table view.

All feature classes in a coverage have FID and Shape
columns. They may also have several pseudo items
whose names begin with a dollar sign ($), which are
maintained by ArcInfo. Because topology only exists for
the polygon feature class, it’s the only one that has a
feature attribute table and, therefore, additional at-
tributes.

9. Click the Preview dropdown arrow at the bottom of the
Preview tab and click Geography.

10. In the Catalog tree, click the minus sign next to the
vegetation coverage. The feature classes are hidden and
the coverage is selected in the Catalog tree. The

Ch02.pmd 02/18/2005, 12:38 PM15



16 USING ARCCATALOG

coverage’s polygon feature class draws in Geography
view.

ArcCatalog draws the first feature class it finds in the
dataset with the highest dimension of geometry avail-
able. If a coverage contained only line and point feature
classes, the first line feature class found would draw in
Geography view.

11. In the Catalog tree, click the plus sign next to the water
feature dataset in the yellowstone geodatabase. The
feature classes it contains appear in the Catalog tree.

12. In the Catalog tree, click each feature class in the water
feature dataset, in turn, and look at their contents in
Geography view. This feature dataset groups feature
classes that contain different types of water features
throughout the park: lakes, rivers, and streams.

13. Click the water feature dataset in the Catalog tree. The
lakes feature class draws in Geography view.

14. Click the hydrology layer in the Catalog tree. This group
layer presents all features in the lakes, rivers, and
streams feature classes using symbology stored in the
layer. When added to a map, a group layer maintains its
grouping in the table of contents.

15. Click the Identify button on the Geography toolbar and
click one of the larger lakes in the Preview tab. Its
attributes appear in the Identify Results window. Only
the larger lakes in this feature class have names.

All features within three pixels of where you clicked are
selected; each feature is listed on the left of the Identify
Results window. If a data source has no text attributes,
a numeric attribute will be used to identify the features.

16. Click the Close button in the upper right corner of the
dialog box to close the Identify Results window.

By exploring a data source’s data in Geography view, you
can find out if it has the features you need and if those
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QUICK-START TUTORIAL 17

features have the correct attributes. This information can
help you decide whether or not to add the data to a map.

Explore the contents of a table

With the table exploration tools available in the Catalog, you
can learn a great deal about a table’s contents. You can
search for values in the table and sort records according to
the values in one or more columns.

The vegetation coverage represents areas with distinct
types of vegetation. The vegtype table contains both
general information, such as whether or not the area is
forested, and detailed information such as which plant
species live in each area. Throughout the park, 67 vegeta-
tion groups have been defined. Some areas, such as open
water or rocky peaks, may not have any vegetation at all.

Use the tools available in Table view to explore the contents
of the vegtype table.

1. Click the vegtype dBASE table in the Catalog tree.

2. Explore the table’s values using the buttons at the
bottom of the table. Once you click in the table you can
also use the arrow keys on the keyboard.

3. Type “10” into the Current record text box and press
Enter. The Current record icon appears next to the tenth
row in the table. The Object ID value for this record,
which is located in the OID column, is nine; the OID
values begin at zero.

4. Scroll horizontally through the table until you see the
column named Primary.

5. Right-click the heading of the Primary column and click
Freeze/Unfreeze Column. The Primary column is frozen
in position at the left of the table, and a heavy black line
appears to its right.

6. Scroll horizontally through the table. The Primary
column stays in place while the other columns scroll
normally. Place the Type column to the right of the
Primary column.

7. Position the mouse pointer over the right edge of the
Primary column’s heading. The mouse pointer changes.

8. Click and drag the edge of the Primary column’s
heading to the left. The red line indicates the edge’s
original position, while the black line shows its new
location. Drop the edge of the column. The column is
narrower.

Current record

Next recordPrevious record

Beginning of table

End of table

Number of
records in
the table
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18 USING ARCCATALOG

9. Right-click the heading of the Type column and click
Freeze/Unfreeze Column. The heavy black line is now
to the right of the Type column. Scroll horizontally
through the table. Both the Primary and Type columns
stay in place while the other columns scroll normally.

10. Click the Type column’s heading. The column is high-
lighted in light blue.

11. Click and drag the Type column’s heading to the left of
the Primary column. The red line indicates the Type
column’s new position. Drop the column in the new
location.

The Type column now appears to the left of the Primary
column, and the heavy black line appears to the right of
the Primary column.

12. Hold down the Ctrl key and click the Primary column’s
heading. Both columns are now selected.

13. Right-click the heading of the Primary column and click
Sort Descending.

The rows in the table are sorted alphabetically in
descending order, first by the values in the Type column,
then by the values in the Primary column. In this format,
the table presents vegetation information from general
to detailed as you look at the columns from left to right.

After exploring the contents of the vegtype table, you have
a better idea about the forest resources that are available in
the study area. However, you may not know what some
column names in the table mean. For that information, you
must look at the table’s metadata.

The Metadata tab

The Metadata tab shows descriptive information about the
selected item in the Catalog tree. Metadata includes
properties and documentation. Properties are derived from
the data source, while documentation is information pro-
vided by a person.

Metadata is stored as extensible markup language (XML)
data in a file with the data or in a geodatabase. The Catalog
uses XSL Transformations (XSLT) stylesheets to transform
the XML data into a hypertext markup language (HTML)
page. You can change the metadata’s appearance by
changing the current stylesheet using the dropdown list on
the Metadata toolbar.
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QUICK-START TUTORIAL 19

You can browse through the available metadata just as you
would browse through any Web page in a browser.

Explore metadata for the tutorial data

The metadata for the Yellowstone folder provides an
overview of the data it contains. By looking at metadata for
the study_area shapefile and vegetation coverage, you can
find out when and why the data was created and look at the
data’s properties.

1. Click the Yellowstone folder in the Catalog tree.

2. Click the Metadata tab. A metadata HTML page
describing the contents of the Yellowstone folder
appears.

3. Click the study_area shapefile in the Catalog tree.
Metadata is presented with the FGDC ESRI stylesheet
by default.

The Catalog automatically adds the item’s current
property values to the metadata when you view it in the
Metadata tab.

4. Click the Stylesheet dropdown arrow on the Metadata
toolbar and click FGDC FAQ. Click the Stylesheet
dropdown arrow again and click FGDC. Different
stylesheets present the same body of metadata in
different ways.
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20 USING ARCCATALOG

5. Click the Stylesheet dropdown arrow on the Metadata
toolbar and click FGDC ESRI.

6. Click the Spatial tab in the metadata.

7. Underneath the name of the coordinate system used by
the data, click Details. The coordinate system’s proper-
ties appear. Click Details again to hide the information.

8. Scroll down to see the shapefile’s extent. Its bounding
coordinates are presented both in the actual coordinates
of the data and in decimal degrees.

9. Click the boundary shapefile in the Catalog tree.

10. Click the Spatial tab in the metadata. No coordinate
system information is available because the shapefile’s
projection hasn’t yet been defined. Scroll down to see
the data’s extent in projected coordinates.

Because there is no coordinate system information, the
Catalog can’t calculate the data’s extent in decimal
degrees. You’ll define the shapefile’s coordinate system
in Exercise 3.

In ArcCatalog, metadata isn’t required to meet any
standard. By default, when you look at metadata in the
Metadata tab, ArcCatalog automatically records the

item’s properties following both the Federal Geographic
Data Committee’s (FGDC) Content Standard for
Digital Geospatial Metadata and the International
Organization for Standardization’s (ISO) standard 19115
Geographic Information—Metadata. The hints you
see in gray text with some stylesheets indicate the
documentation that must be completed to meet the
standard’s minimum requirements.

11. Click the vegtype table in the Catalog tree.

12. Click the Spatial tab in the metadata. The table doesn’t
contain spatial information. But, because the information
it contains only applies to Yellowstone National Park, the
extent of the Park has been provided manually. There-
fore, the table can be found by a spatial search.

13. Click the Attributes tab in the metadata. All columns in
the table are listed.

14. Click the LATIN3 column in the list. You can see a
description of its data type and values.

15. Click the Contents tab in the ArcCatalog window.

Now that you’ve familiarized yourself with the data, you
can create a map describing the study area within
Yellowstone National Park.
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QUICK-START TUTORIAL 21

Add a layer to a map

The Yellowstone folder contains a map document. The map
already has data from the roads feature class and the
hillshade raster dataset. You must still add the water
features in the park to the map.

Adding data to a map is easy—all you have to do is drag
data from the Catalog and drop it on the map. When you
drop a layer onto a map, a copy of the layer is created and
stored inside the map document. In this way, you can create
a layer once and use it in many different maps. Before you
can add more data to the Yellowstone map, you must open
the map document in ArcMap.

1. Click the Yellowstone folder in the Catalog tree.

2. Double-click the yellowstone map document in the
Catalog; it opens in ArcMap.

In the ArcMap window, you see the contents of the
Study Area data frame in Data view; the name of the
active data frame appears in bold in the table of

contents. The map has two other data frames as well:
Yellowstone National Park and United States.

3. Arrange the ArcMap and ArcCatalog windows so you
can see the table of contents in ArcMap and the Catalog
tree at the same time.

Water features must be added to the map; they should
draw underneath the park roads layer but above the
hillshade layer. The map’s table of contents reflects the
order in which layers are drawn.

4. Click and drag the hydrology layer from the Catalog and
drop it in the map’s table of contents below park roads
in the Study Area data frame’s list of layers.
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22 USING ARCCATALOG

5. In the ArcMap window, click the Save button.

The water features draw underneath the road features
and above the hillshade image in the map.

Create layers

The features in the park roads and hydrology layers cover
the entire park, but you only want to map the study area.
The mask shapefile represents the area outside the study
area. You can create a layer from this shapefile in the
Catalog and add it to the map to hide features that extend
beyond the study area.

If you add data directly to a map rather than creating a
layer first, ArcMap creates a new layer in the map docu-
ment. After modifying the layer’s symbology and other
properties, you can save it as a layer file outside the map
document so you can reuse it in other maps.

In this task, you will first save the park roads layer to a file,
then create a new layer representing the mask shapefile.

1. Right-click the park roads layer in the map’s table of
contents and click Save As Layer File.

2. In the Save Layer dialog box, navigate to the
Yellowstone folder. Type a name for the new layer, for
example, “park roads”, then click Save.

3. In the Catalog tree, click the Yellowstone folder.

4. Click the View menu and click Refresh. The park roads
layer now appears in the Contents list.

5. Right-click the mask shapefile and click Create Layer.

6. Navigate to the Yellowstone folder in the Save Layer As
dialog box. Type a name for the new layer, for example,
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“feature mask”, then click Save. The layer appears in
the Contents list for the Yellowstone folder.

7. Right-click the feature mask layer and click Properties.
The Layer Properties dialog box appears.

8. Click the Symbology tab.

9. Click the button showing the current symbol for the
layer. A symbol is assigned at random when the layer is
created.

10. Click the dropdown arrow next to the Fill Color symbol
and click white.

11. Click the dropdown arrow next to the Outline Color
symbol and click black.

12. Click OK in the Symbol Selector dialog box and click
OK in the Layer Properties dialog box.

Now that you’ve finished creating the feature mask layer,
you should document its contents. Before adding it to the
map, you can import metadata, which has already been
created for the layer.

Import metadata

There is a text file in the Yellowstone folder containing
metadata describing the feature mask layer. By importing
this metadata it will become part of the layer itself; it will be
copied and moved with the data and updated automatically
by ArcCatalog. This is useful because when metadata is
maintained separately, it is easy to let it get outdated.

9
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1. Click the feature mask layer in the Catalog tree. Notice
that the layer’s icon appears on a gray background
because a thumbnail hasn’t yet been created.

2. Click the Metadata tab. By default, ArcCatalog auto-
matically creates metadata for the feature mask layer.
Properties such as the name of the layer file will be
added automatically along with hints about the type of
documentation you should provide.

3. Click the Import metadata button on the Metadata
toolbar.

4. Click the Format dropdown list and click FGDC
CSDGM (TXT). Metadata in text files can be imported
if the information is structured following the format
supported by the FGDC’s metadata parser, mp.

5. Click Browse and navigate to the Yellowstone folder.

6. Click the Files of type dropdown arrow and click All
files (*.*). Click the file “feature_mask.met” and click
Open.

7. Click OK in the Import Metadata dialog box. The
information in the feature_mask.met file replaces the
metadata generated by ArcCatalog. Then, properties of
the layer are automatically added to it.

Now there is just one thing missing from the layer’s
metadata—a thumbnail describing how the layer will
appear when added to a map. Creating thumbnails for
data sources and layers is a manual process.

8. Click the Preview tab.

Import metadata
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9. Click the Create Thumbnail button on the Geography
toolbar.

10. Click the Contents tab. You can see the thumbnail both
here and in the layer’s metadata.

After adding or removing features from a data source or
changing a layer’s symbology, you may wish to update the
item’s thumbnail.

Search for items

You’ve explored the contents of the Yellowstone folder and
created the new feature mask layer, and soon you’ll add it
to your map. However, often you know what data you need
to use but not where it’s located. The Catalog lets you
search for data by its name, type, and geographic location.
You can also search for data using dates and keywords that
reside in the data’s metadata. When metadata exists, its

name, type, and geographic location are derived from the
metadata as well.

Suppose you didn’t know the feature mask layer existed.
You need to add a data source to the Yellowstone map that
shows the boundary of the study area within the park.

1. Right-click the Yellowstone folder in the Catalog tree
and click Search. The Search dialog box appears, and
the location in which the search will begin looking is
automatically set to the Yellowstone folder.

2. Click the Advanced tab.

3. Click the Metadata element dropdown arrow, scroll
down, and click Theme Keyword in the list.

4. Click the Condition dropdown arrow and click equals.

5. Click in the Value text box and type “boundary”.

6. Click Add to List.

Create Thumbnail
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With this search, ArcCatalog will look in the Yellowstone
folder for items whose metadata includes the theme
keyword boundary.

7. Click Find Now.

The search is saved in the Search Results folder and is
selected in the Catalog tree. As the items are found that
satisfy the search criteria, shortcuts to those items are
added to the search’s list of results. When a Search is
complete, the message “Catalog search finished”
appears in the status bar of the ArcCatalog window and
the Stop button becomes unavailable in the Search
dialog box.

8. Click the Close button in the upper-right corner of the
Search dialog box.

The Catalog has found four items in the Yellowstone
folder that satisfy the search criteria: three shapefiles
and the feature mask layer. Shortcuts to these items
appear in the Contents tab. In the Catalog, you can
work with shortcuts the same way you would work with
the items themselves.

9. Click the shortcut to the feature mask layer in the
Contents tab.

10. Click the Preview tab to draw the layer.

11. Click the Metadata tab to see the layer’s metadata.

This is the data you want to add to your map.

12. Click and drag the shortcut to the feature mask layer
from the Catalog and drop it in the map’s table of
contents above park roads in the Study Area data
frame’s list of layers. Now you only see features inside
the study area on the map.
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13. Click the Save button.

The Yellowstone map now contains all the basic data
needed to represent the study area. Now all you need to do
is add a few finishing touches to the map’s layout.

Complete the map

The purpose of the Yellowstone map is to illustrate the
different types of vegetation within the study area. Cur-
rently, the Study Area data frame shows most of the park.
You need to zoom in on the study area; do this in layout
view to make sure you’re zoomed in as far as possible but
still able to see the entire study area in the layout. When
you switch to layout view, you’ll see the Yellowstone
National Park and United States data frames as well.

1. Click the View menu and click Layout view. You can
see all the data frames and the map’s title and scalebar
in the layout.

In the Yellowstone National Park data frame, there is an
orange rectangle representing the area that you can see

within the Study Area data frame. Similarly, in the
United States data frame, there is a green rectangle
representing the area that you can see within the
Yellowstone National Park data frame.

When you zoom farther in to the features in the Study
Area data frame, the extent rectangle on the
Yellowstone National Park data frame decreases in size
and the scalebar increases in size.

2. In ArcMap, click the Zoom In button on the Tools
toolbar and draw a rectangle around the study area in
the Study Area data frame.

If you zoom in too close, you can return to your previous
extent by clicking the Go Back To Previous Extent
button.

Zoom In Go Back To Previous Extent
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3. When the study area fills the Study Area data frame,
click the Save button.

4. Click the File menu and click Exit to stop ArcMap.

In this exercise, you saw how to explore your data in the
Catalog, create layers, import metadata, search for items,
and add them to maps. In the next exercise, you’ll create a
layer illustrating the different types of vegetation that can
be found within the study area. This requires changing a
data source to a different format and modifying its values.

You can continue on to the next exercise or stop and
complete the tutorial at a later time. If you do not move on
to the next exercise now, do not delete your working copy
of the tutorial data. Also, do not remove the folder connec-
tion that accesses the working copy of the tutorial data
from the Catalog.
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Exercise 3: Managing shapefiles

Assembling data for a project often requires significant data
management work. In this exercise, you will create a layer
representing the different types of vegetation in the study
area and add it to the Yellowstone map. In doing so, you’ll
learn how to define a shapefile’s coordinate system, modify
attributes, join a table’s attributes to a shapefile, and update
metadata using tools that are available in ArcCatalog.

Define a shapefile’s coordinate system

In the previous exercise, when you looked at metadata for
the boundary shapefile, you found that its coordinate system
was not defined. The features in the shapefile are pro-
jected, but the Catalog doesn’t know which map projection
was used. Without that information, the Catalog can’t
determine where on the earth’s surface the features are
located.

A shapefile’s Properties dialog box lets you modify its
attributes, create spatial and attribute indexes, and define its
projection.

1. In ArcCatalog, click the Contents tab and click the
Yellowstone folder in the Catalog tree.

2. In the Contents list, right-click the boundary shapefile
and click Properties.

3. Click the Fields tab.

4. Under Field Name, click Shape. This column contains
the feature geometry. The shapefile’s spatial properties
appear in the Field Properties list below.

At the bottom of the list is the Spatial Reference
property. The shapefile’s coordinate system is unknown.

5. Click the ellipses (...) button to the right of the Spatial
Reference property.

All data sources in the Yellowstone folder except for the
states coverage use the same projection. You can copy
coordinate system information from any data source in
the folder except states to this shapefile.

6. Click Import in the Spatial Reference Properties dialog
box.

7. Navigate to the Yellowstone folder, click the dem30
raster dataset, then click Add. The projection param-
eters from the dem30 raster dataset appear in the
Spatial Reference Properties dialog box.

8. Click OK. The shapefile’s coordinate system appears in
the Shape column’s Spatial Reference property.

5
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9. Click OK.

A shapefile’s coordinate system information is stored in
a .prj file with the data—for example, boundary.prj.
Now you can update the shapefile’s metadata with the
new coordinate system information. By default, every
time you look at metadata in the Metadata tab, the
Catalog automatically updates the metadata with the
data source’s current properties.

10. Click the Metadata tab.

11. Click the Spatial tab in the metadata.

ArcCatalog has updated the coordinate system in the
metadata and has calculated the shapefile’s extent in
decimal degrees.

Modify attributes in dBASE tables

A layer can join or relate attributes in a table of any format
to its geographic data source as long as they share a
column of values. The only requirement is that the columns
have the same data type. Land cover information in the
vegtype dBASE table can be joined to the vegetation

coverage’s polygon feature class to describe the land cover
in each area. You must look at the polygon feature class’s
attributes and the vegtype table’s columns to see if modifi-
cations are required before they can be joined together.

Using Table view, you can see that the “CODE” attribute in
the vegetation polygon feature class and the “VEGID”
column in the vegtype table look like they contain related
values and that the vegtype table has two columns that
contain no values. Use the polygon feature class’s Proper-
ties dialog box to check the CODE attribute’s data type,
then use the table’s Properties dialog box to check the
VEGID column’s data type and modify its columns appro-
priately.

1. Click the Contents tab in the ArcCatalog window.

2. Click the vegetation coverage in the Catalog tree.

3. Right-click the polygon feature class in the Contents list
and click Properties.

4. Click the Items tab. The columns in the feature class’s
attribute table are listed. You can see that the CODE
attribute’s data type is Float.

5. Click Cancel.

6. Right-click the vegtype table in the Catalog tree and
click Properties.
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7. Click the Fields tab. The table’s columns and their data
types are listed. You can see that the VEGID column’s
data type is Long Integer.

The VEGID column in the dBASE table contains
integers, while the CODE column in the polygon feature
class contains real numbers. To join the table to the
feature class, each item must have a column containing
the same values. Both columns must also have the same
data type. Therefore, you must add a floating point
column to the table.

8. Scroll to the bottom of the list of column names. Click in
the empty row under the name of the last attribute and
type “VEGTYPE”.

9. Click under Data Type to the right of the new column’s
name, click the dropdown arrow that appears, then click
Float.

10. In the Field Properties list below, click to the right of
Precision, click again, then replace the zero with “4”.

11. Click to the right of Scale and replace the zero with “1”.

The new attribute has been defined. Now you can
remove the empty columns from the table.

12. Point at the gray button to the left of the NAME3
column; the mouse pointer changes to an arrow. Click to
select the column.

13. Press Delete. The column is removed from the list.

14. Repeat steps 11 and 12 for the LATIN3 column to
delete it from the table.

15. Click OK.

Now that the vegetation shapefile has a new integer
attribute, you must copy the values in the original VEGID
attribute to the new VEGTYPE attribute. To edit the values
in a table, you must use ArcMap.

Calculate attribute values in ArcMap

To edit a table’s values you must add the table to a map.
With the Editor toolbar visible and the table opened, you can
start editing its values. Use the field calculator to copy
values from the CODE attribute to the VALUE attribute.

1. Click the Launch ArcMap button in ArcCatalog.

Launch ArcMap
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2. Click OK to start using ArcMap with a new, empty
map.

3. Drag the vegtype table from the Catalog and drop it
onto the table of contents or the canvas in the ArcMap
window. The table appears in the Source tab in the
map’s table of contents. The table’s data is now avail-
able within the map.

4. Click the Editor Toolbar button; the Editor toolbar
appears.

5. On the Editor toolbar, click the Editor menu and click
Start Editing.

6. Right-click the vegtype table and click Open. The
table’s values appear in a table window. The headings of
the columns whose values you can change have a white
background.

7. Click the heading of the VEGID column to select the
column.

8. Scroll horizontally in the table until you see the
VEGTYPE column.

9. Hold the Ctrl key and select the heading of the
VEGTYPE column.

10. Right-click the heading of the VEGTYPE column and
click Freeze/Unfreeze Column. Both VEGID and
VEGTYPE are now positioned at the left of the table
with a heavy black line to their right.

11. Right-click the heading of the VEGTYPE column and
click Calculate Values.

12. Scroll down and double-click VEGID in the Fields list.
[VEGID] appears in the text box below VEGTYPE =.
ArcMap reads this as VEGTYPE=[VEGID]. This
means for each row in the table, the value in the
VEGTYPE column will be set equal to the value stored
in the VEGID column.

Editor Toolbar
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13. Click OK.

As ArcMap calculates the new values in each record,
you can see how many records have been completed at
the bottom of the Field Calculation dialog box.

14. Look at the VEGTYPE column in the table; its contents
are the same as the VEGID column.

15. Click the Close button in the top-right corner of the table
window.

16. Click the Editor menu on the Editor toolbar and click
Stop Editing. Click Yes to save your changes.

17. Click the File menu and click Exit to stop ArcMap. Click
No when prompted to save the map.

Update the table’s metadata

In the previous two tasks you removed and added columns
from and to the vegtype table, then populated the new
column with values. Now you should update information
about the table’s columns in its metadata.

1. Click the Metadata tab.

2. Click the Attributes tab in the metadata. ArcCatalog has
automatically updated the metadata to remove informa-
tion about the columns that were deleted from the table.

3. Click VEGTYPE in the list of columns. The data type of
this column was added to the metadata automatically.

To describe the data contained in the VEGTYPE
column, use the Catalog’s FGDC metadata editor.

4. Click the Edit Metadata button on the Metadata toolbar.

5. Click Entity Attribute at the top of the metadata editor.
The editor is currently showing you metadata for the
polygon feature class.

6. Within the Detailed Description tab, click the Attribute
tab.

Edit Metadata
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The Attribute tab currently shows metadata for the first
column in the vegtype table, the OID column. The
Definition text box shows that this column contains a
unique value for each record in the table.

7. In the toolbar at the bottom of the Attribute tab, click the
Move next button. The column displayed in the Attribute
tab advances to the next one listed in the table’s
metadata—the VEGID column, which contains integers
identifying each type of land cover.

8. Click the Move last button to see the VEGTYPE
column.

9. Click in the Definition text box and type, “A real number
identifying the type of land cover. Use this column to
join this table to the vegetation coverage.”

10. Click Save.

11. Click the Attributes tab in the metadata.

12. Click the VEGTYPE column. The description you
added appears in the metadata. Anyone who uses this
table in the future will be able to find out what data this
column contains.

Now that the vegetation coverage and the vegtype table
have matching columns, you can create a layer that links
the two together.

Create a layer using the related attributes

Through a layer you can join the attributes stored in the
vegtype table to the vegetation coverage and use the table’s
values to query, label, and symbolize the coverage’s fea-
tures.

1. Click the Contents tab in the ArcCatalog window.

2. Click the Yellowstone folder in the Catalog tree.

3. Click the File menu, point to New, then click Layer.

4. Type a name for the layer such as “vegetation type”.

5. Click the Browse button, navigate to the Yellowstone
folder, click the vegetation coverage, then click Add.

6. Check Store relative path name, then click OK.

Move next Move last
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A relative path specifies the location of the data used by
the layer relative to the location of the layer file on disk.
Since relative paths don’t contain drive names, they let
you continue using the layer even after moving or
renaming the Yellowstone folder, without having to
repair the layer.

7. Right-click the vegetation type layer and click
Properties.

8. Click the Joins & Relates tab in the Layer Properties
dialog box.

9. Click the Add button next to the Joins list.

10. Click the first dropdown arrow to specify what you
want to join to this layer, then click Join attributes from a
table.

11. Under step 1, click the dropdown arrow and click the
CODE attribute.

12. Under step 2, click the Browse button.

13. Navigate to the Yellowstone folder, click the vegtype
table, and click Add.

14. Under step 3, click the dropdown arrow and click the
VEGTYPE column.

15. Click OK in the Join Data dialog box. The vegtype table
is added to the list of tables that have been joined to the
coverage.

16. Click Yes to create an index.

17. Click the Symbology tab.

18. Click Categories in the Show list.

19. Click the Value Field dropdown arrow and click
vegtype.TYPE.

Q
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20. Click the Color Ramp dropdown arrow and click a
different color palette, if desired.

21. Click Add All Values.

To change the color of individual values, for example, to
make the water polygons blue, double-click the patch of
color to the left of the value. Set the fill and outline
colors in the Symbol Selector dialog box and click OK.

22. Click OK in the Layer Properties dialog box.

The vegetation type layer represents the forest resources in
the study area.

Add the vegetation type layer to the map

Now that the vegetation layer has been created, you can
add it to the Yellowstone map.

1. Double-click the Yellowstone map in the Catalog.

2. Click and drag the vegetation type layer from the
Catalog and drop it in the map’s table of contents below
park roads and above hydrology in the Study Area data
frame’s list of layers.

3. Click the Save button in ArcMap.

4. Click the File menu and click Exit to stop ArcMap.

The Yellowstone map is now complete.

You’re now finished with the Quick-start tutorial. This
exercise showed how to use ArcCatalog to manage
shapefiles and dBASE tables including how to define a
coordinate system and add and remove attributes.

Overall, this tutorial has introduced you to a wide range of
tasks. Whether you are looking for data, building maps, or
managing data for your project or an entire organization,
ArcCatalog plays a pivotal role in getting the job done. The
remaining chapters in this book look in detail at the variety
of tasks you can accomplish with ArcCatalog.
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